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© 2010. All rights are reserved. No portion of this document may be reproduced without
permission.

All trademarks and brand names mentioned in this publication are property of their
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Liability
While all efforts have been made to ensure the accuracy of all contents in this manual,
we assume no liability for errors or omissions or by statements of any kind in this manual,
whether such errors are omissions or statements resulting from negligence, accidents, or
any other cause. The contents of this manual are subject to change without notice.

Copyright
The scanning of certain documents, for example checks, bank notes, |.D. cards,
government bonds, or public documents, may be prohibited by law and/or subject to
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copyrights laws when you are scanning books, magazines, journals and other materials.

Environmental Information
The product is designed and produced to achieve sustainable environmental
improvement. We strive to produce products in compliance with global environmental
standards. Please consult your local authorities for proper disposal.

The product packaging is recyclable.

Attention for recycling (For EU country only)
Protect your environment! This product should not be thrown into the household waste
container. Please give it to the free collecting center in your commune.

Screen Examples in This Manual
The screen shots in this guide were made with Windows XP. If you are using Windows
2000 / Vista/ 7, your screen will look somewhat different but functions the same.
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INTRODUCTION

Thank you for choosing us as your scanner supplier. Your new scanner will
improve the professionalism of your day-to-day computing tasks by allowing you to
input images and electronic text into your computer system. You can easily scan
single-sided or double-sided documents with your scanner.

Like all of our products, your new scanner is thoroughly tested and backed by our
reputation for unsurpassed dependability and customer satisfaction. We hope you will
continue to turn to us for additional quality products as your computing needs and
interests grow.

How 170 USE THIS GUIDE

This User's Guide provides instructions and illustrations on how to install and
operate your scanner. This guide assumes the user is familiar with Microsoft Windows
2000 Professional/ XP/ Vista/ 7. If this is not the case, we suggest you learn more
about Microsoft Windows by referring to your Microsoft Windows manual before using
your scanner.

The Introduction section of this manual describes the box contents and minimum
computer requirements to use this scanner. Before you start installing your scanner,
check the box contents to make sure all parts are included. If any items are damaged
or missing, please contact the vendor where you purchased your scanner or our
customer service directly.

Chapter | describes how to install scanner’s software and connect the scanner to
your computer. Note: The scanner connects to your computer through the Universal
Serial Bus (USB). If your computer does not support USB technology, you will need to
purchase a USB interface card to add USB capabilities to your computer, or buy and
install USB connectors if your motherboard has USB capabilities. This guide assumes
that your computer is USB-ready and has a free USB port.

Chapter Il describes how to use your scanner.
Chapter Ill describes how to maintain and clean your scanner.

Chapter IV contains technical support information that can help you solve simple
problems.

Appendix A contains the specifications of the scanner you purchased.

Appendix B contains our customer service, the limited warranty agreement and
FCC statement concerning the product.



CONVENTIONS OF THIS GUIDE

Bold —Represents commands or contents on your computer screen.
ALL CAPS —Important note or first use of an important term in a chapter.

Iltalic —Represents buttons on your scanner OR important notes.

A Note about Icons

This guide uses the following icons to point out information that deserves special
attention.

A A procedure that must be followed carefully to prevent
Warning injury, or accidents.

Putention-
Q Instructions that are important to remember and may
Attention prevent mistakes.

Optional tips for your reference.
Information

SAFETY PRECAUTIONS

Before using this device, please read the following important
information to eliminate or reduce any possibility of causing

damage and personal injury.

Warning

1. Moisture condensation may occur inside this device and cause malfunction at
these conditions:

® when this device is moved directly from a cold to a warm location;
® after a cold room is heated;
® when this device is placed in a damp room.

To avoid the moisture condensation, you are recommended to follow the procedure:
i. Seal this device in a plastic bag for it to adapt to room conditions.
ii. Wait for 1-2 hours before removing this device from the bag.

2. Do use the AC adapter and USB cable provided with the scanner. Use of other AC
adapter and cables may lead to malfunction.

3. Keep the space around the AC adapter clear in case you need to quickly unplug
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the AC adapter during emergencies.

4. Damaged wire could cause fire or electrical shock. Keep the power cord straight
and without being twisted, bended, or scraped.

5. Unplug this device if you don’t need to use for a certain period of time, such as,
during night or long weekend, to avoid any risks of causing fire.

6. Do not attempt to disassemble the scanner. There is danger of an electrical shock
and opening your scanner will void your warranty.

Be sure not to bump or knock the scanner glass as it is fragile and could break.

Do not subject the scanner to excessive vibration. It may damage the internal
components.

MINIMUM SYSTEM REQUIREMENTS?
PC with Intel Pentium®lIl 1G processor or compatible
256 MB RAM

Available USB 2.0 port

CD-ROM Drive or DVD-ROM Drive

800 MB Free Hard Disk Space

Video card that supports 16-bit color or greater

Operating System: Windows 2000 Professional, Windows XP Home (compatible),
Windows XP Professional (compatible), Windows Vista or Windows 7

0 Systems with Pentium® 1.8G or higher processor (or its
compatible), 512 MB RAM and 1GB free hard disk space
are recommended for optimal performance.

Information

! Higher requirements may be needed when scanning or editing large quantities of images. The
system requirements stated are only a guideline, generally the better the computer
(motherboard, processor, hard disk, RAM, video graphic card), the better the results.



BoX CONTENTS?

Scanner

USB Cable

AC Adapter
Protection Sheet

Scanner User’s Guide
Setup/Application CD-ROM

Calibration Sheet

Memo Label

9. Extended Paper Width Slider (2 pieces)
10. Read Me First

11. Cleansing Cloth

12. Pad Module

© N O R 0Dd =

% Save the box and packing materials in case you need to transport this scanner in the future.



THE SCANNER FEATURES

1. PAPER CHUTE COVER—Helps keep the paper in place. Open paper chute cover
when using the scanner.

2. PAPER WIDTH SLIDER—Adjusts the paper width slider for the paper size you are

using.
o

Information

Extended Paper Width Slider (accessory in the box
content) —Hold the paper uprightly so as to avoid the paper
feeding to be askew.

3. COVER OPEN LEVER—Opens the ADF cover. Pull it to open the ADF cover
when you need to clear paper jam or clean the scanner.

4. PAPER STOP— Holds paper in place when it is ejected from the ADF. Extend it in
case of longer paper.

5. POWER LED—Indicates the scanner status.

Light Status
On The scanner is turned on, ready to scan images.
Off

The scanner is off, either because the power is not turned on, or
because the AC adapter is not properly plugged into an AC power
outlet.




10.

11.

12.

13.

14.

15.

ADF (AUTOMATIC DOCUMENT FEEDER)—Automatically feeds a stack of
documents for scanning.

SIDE GUIDE—Holds the paper in place to be scanned through the ADF. Pull side
guides out to hold the paper.

PAPER CHUTE EXTENSION—Extends to hold longer paper.

O ®© & @

FUNCTION NUMBER DISPLAY—Indicates the number of the predefined scanning
task selected by the up or down button.

UP BUTTON—Press to move forward the scanning task number indicated in the
function number display.

DOWN BUTTON—Press to move backward the scanning task number indicated in
the function number display.

SCAN BUTTON—Press to perform a predefined scanning task selected by the up
or down button.

/ _/’«- ———
| —_ .
ﬂ_‘—_
® o .

POWER RECEPTOR—Connects the scanner to a standard AC power outlet by the
included AC adapter.

USB PORT—Connects the scanner to a USB port on your computer by the
included USB cable.

POWER SWITCH—Use this to turn the scanner ON or OFF.



/
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16. DOCUMENT COVER— Helps keep the paper in place and protects the scanner
glass.

17. DOCUMENT PAD— Keeps the paper in place and improves accuracy of image
quality.

18. SCANNER GLASS— Where you put items for flatbed scanning.

19. REFERENCE MARK— Align your paper with this reference mark in case of flatbed
scanning.



CHAPTER I. INSTALLING THE SCANNER

Before installing your scanner, please verify that you have all of the proper
components. A list of the package contents is provided in the “Box Contents” section
of this guide.

SOFTWARE INSTALLATION REQUIREMENTS

Your scanner comes with the image-editing software (NewSoft Presto! ImageFolio),
OCR software (ABBYY FineReader 6.0 Sprint, DI Express), Business card Recognition
Software (HotCard BizCard Finder), document management software (NewSoft Presto!
PageManager), the scanner’s driver, FounderAction, and the image capture software
(FounderScan). All of these software applications use approximately 800 megabytes of
hard disk space after they are installed into your computer. To ensure ample room for
the installation, as well as for scanning and saving images, a minimum of 1 GB of hard
disk space is recommended.

This USB scanner can only operate under the Microsoft Windows 2000
Professional/ XP/ Vista/ 7 operating system.

HARDWARE REQUIREMENTS

This scanner connects to your computer through the Universal Serial Bus (USB)
which supports HOT PLUG AND PLAY. To determine whether your computer is USB-
capable, you must check the rear of your PC to locate a USB jack that looks like the
picture below. If you are having trouble in locating the USB port on your computer,
please refer to the hardware manual that came with your computer.

Upon examination, you should find one or two rectangular USB ports, which usually
appear as shown below.

TV TITTIY

USB Connector(s)

If you don’t find such USB ports on your computer, then you need to purchase a
certified USB interface card to add USB capabilities to your computer.
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INSTALLING AND SETTING UP THE SCANNER

Please follow the step-by-step procedures described below to install the scanner.

Choose a Proper Site First!
® Always place your scanner on a level, smooth and
strong surface before proceeding the scanner setup or

§ any scanning task. Tilted or uneven surface may
Q‘""“"' cause paper-feeding errors, scanner damage or
Attention personal injury.

® Avoid using the scanner in a dusty environment. Dust
particles and other foreign objects may damage the
unit.

Step 1. Connecting the Scanner to Your Computer

[

-

g . Please make sure the scanner is turned OFF
B before you plug or unplug the scanner power




Attention adapter.

Plug the AC adapter into the scanner’s power receptor ——@+
Plug the other end of the AC adapter into a standard AC power outlet.

Plug the square end of the included USB cable to the USB port *<<>* at the rear of
the scanner.

Plug the rectangular end of the USB cable to an available USB port on your
computer.

If you plan to connect your scanner to a USB hub®, make sure that the hub is
connected to the USB port in your computer. Next, connect the scanner to the
USB hub.

Step 2. Installing the Software

1.
2.

Switch on the scanner power from the rear of the scanner.

If the USB components on your computer are functioning correctly, they will
automatically detect the scanner causing the Add New Hardware Wizard or
Found New Hardware Wizard to be launched.

0 If your computer is off when the scanner is connected, the
] “Add New Hardware Wizard” message will not be displayed
Information until the computer is on and Windows starts.
For Windows 2000:

a. Click the Next button when the “Add New Hardware Wizard” window is
displayed.

b. Select Search for the Best Driver for Your Device [Recommended] and
click the Next button.

c. The next window will ask you where to search to find the drive. Select CD-
ROM drive, and deselect Floppy disk drives if it is checked.

—

’ P>

d. Insert the Setup/Application CD-ROM, included with your scanner, into your
CD-ROM drive and then click the Next button.

e. Click the Next button in the window that appears.

f. During the process of the installation, a message “Digital Signature required”
might be prompted. Please ignore it, and click the Yes button to continue the
installation without any misgiving at your scanner functioning. Afterwards,
please skip to procedure 8.

® The USB hub is not included with the scanner.
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4. For Windows XP:

a. Insert the Setup/Application CD-ROM, included with your scanner, into your
CD-ROM drive.

b. Select Install the software automatically recommended and click the Next
button.

c. Click the Next button in the window that appears. Afterwards, please skip to
procedure 8.

5. For Windows Vista:

a. Select “Locate and install driver software (recommended)” when the “Found
New Hardware” window is displayed.

b. Click on the [Continue] button when the “User Account Control” dialog pops up.

c. Insert the Setup/Application CD-ROM, included with your scanner, into your
CD-ROM drive when the system prompts you “Insert the disc that came with
your USB Scanner” - and click on the [Next] button. Afterwards, please skip

to procedure 8.
6. For Windows 7:

a. Insert the Setup/Application CD-ROM, included with your scanner, into your
CD-ROM drive. Close the AutoPlay window that appears.

b. From the Windows Start menu, right click on the Computer and select
Properties from the pop-up menu. Click Device Manager on the following
screen.

c. In the Device Manager window, right click on this scanner under Other
devices item and select Update Driver Software from the pop-up menu. Click
Browse my computer for driver software in the window that appears, and
click the Browse button.

d. In the Browse For Folder window, select the folder that contains this scanner
driver and click the OK button to return to the previous screen. Click the Next
button. Afterwards, please skip to procedure 8.

7. During the process of the installation, a message “Windows can't verify the
publisher of this driver software” might be prompted. Please ignore it, and click on
[Install this driver software anyway] to continue the installation without any
misgiving at your scanner functioning.

8. When the system completes the installation, click the Finish button.

9. Follow the on-screen instructions to install all software that your new scanner
requires.

13. After the software is installed, close all open applications and click the Finish
button to restart your computer.

14. After the computer is restarted, you will be prompted to perform the scanner
calibration.
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15. Insert the special calibration sheet into the ADF of the scanner, with arrows toward
the scanner buttons.

16. Follow the on-screen instructions to complete the scanner calibration.

After the calibration is complete, click OK and then click Finish.

o If the scanner installation is not started and displayed
Information automatically on the screen, click Start, select Run and type
in D:\Install (where D: is the drive letter assigned to the CD-

ROM drive of your computer.)

Step 3. Install the Extended Paper Width Slider

1. Open the ADF cover by pulling the lever, and get the right and left extended paper
width sliders ready.

2. Align and Insert the left extended paper width slider onto the paper width slider on
the left. Position and Insert the right extended paper width slider onto the paper
width slider on the right.

12



Step 4. Testing the Scanner

The following describes how you can check if the scanner is properly functioning
with your computer and the scanning software by performing your first scan with our
bundled image-editing application NewSoft Presto! ImageFolio. Before testing your
scanner, double check to make sure that all connections are securely fastened.

To test the flatbed scanning:
1. Open the scanner's document cover. Place a document face down onto the

scanner glass and align the document top with the = reference mark.

2. Gently close the document cover.
3. Click the Windows Start button to launch NewSoft Presto! ImageFolio.

4. (If you have only one scanner connected with your computer, please skip to
Step 5.)
If you have more than one scanner or other imaging device installed on your
computer: Click Select Source from the File menu of Presto! ImageFolio and
then choose this scanner as the default scanning source.

Within Presto! ImageFolio, click File > Acquire > Acquire.
In the TWAIN window that opens, select Flatbed Reflective as the Scan Type.
Click the Scan button.

©® N o o

If an image appears on your screen, your scanner is working properly.

To test the ADF scanning:

1. Load a document headfirst and face down into the ADF with the text side facing
the paper chute. (For detailed instructions on loading paper into the ADF,
please refer to the “Placing Documents” section on page 17 of this guide.)
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2. Click the Windows Start button to launch NewSoft Presto! ImageFolio.

3. (If you have only one scanner connected with your computer, please skip to
Step 4.)
If you have more than one scanner or other imaging device installed on your
computer: Click Select Source from the File menu of Presto! ImageFolio and
then choose this scanner as the default scanning source.

Within Presto! ImageFolio, click File > Acquire > Acquire.
Select ADF (Front Side) as the Scan Type within the TWAIN window.
Click the Scan button.

N o o &

The document in the ADF paper chute should be now loaded into the ADF and
scanned. After this process, you should see a scanned image of the document
on your screen.

8. Click Exit to exit the TWAIN window.

INSTALLING ADDITIONAL SOFTWARE

Your scanner is TWAIN compliant and functions with virtually all available TWAIN
compatible software. If you purchase additional software to be used with your scanner,
please make sure that it conforms to the TWAIN standard.

14



CHAPTER II. SCANNING

Your scanner needs to be driven by certain type of software program. Since all
documents or images (whether text or pictures) that are acquired from the scanner are
treated by your computer as images, most scanning will probably be done from an
image-editing program where you can view, edit, save and output the scanned images.
An image-editing program has been bundled for your scanner on the included
Setup/Application CD-ROM. It will allow you to alter and correct any scanned images
by using a variety of filters, tools and effects.

What about scanning text documents and editing them in a word processor? This is
the role of Optical Character Recognition (OCR) software. OCR software converts the
image files that are created from scanning text documents into text files that can be
viewed, edited and saved by word processors. An OCR program has also been
bundled on the included Setup/Application CD-ROM, and if you wish to use the
scanner in this way you should install the OCR software that is included.

FounderScan, as its name suggests, is a specialized document image capture
program that allows you to conveniently digitize your paper documents and
automatically save their electronic files in the designated folder. If you are not familiar
with scanning, no problem: the Scan Wizard will guide you through to complete each
scanning task.

The FounderAction program, seamlessly integrating the operation of your scanner
with your computer and other peripherals, provides a quick and convenient way to
perform various scanning functions. With FounderAction, you don't need to adjust
settings every time you scan. Simply press any button on the scanner's front panel or
click any scanning menu item of FounderAction on the screen. The scanner starts to
scan your paper documents and transfer them to your assigned destination. The
destination can be a printer, your E-mail program, files on your disk drives, an image-
editing program, etc.

Please refer to the online help of each program to guide you through any questions
you may have while scanning within that program.

This chapter describes three important steps of scanner operations. Read them
thoroughly and follow the instructions to ensure correct use and optimal scanner
performance.

Step 1. Preparing Documents

Step 2. Placing Documents, Placing Business Cards, Placing Plastic Cards,
Placing Documents with the Protection Sheet

Step 3. Scanning Documents

PREPARING DOCUMENTS
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Proper document preparation prior to the scan can prevent paper feed errors and
damages to the scanner.
B Checking Document Conditions
B |Loosening Documents

Checking Document Conditions

Make sure the size and ream weight of your documents are acceptable by the
scanner. Refer to “Appendix A: Specifications” of this guide for more information.

To scan multiple documents in a batch from the ADF can increase your work
efficiency and make large scanning tasks easier. The ADF of this scanner accepts a
variety of paper and stationery you may use in your daily work or personal life, such as:

B Normal paper whose size and ream weight meet the requirements stated in
“Appendix A: Specifications” of this guide.

B Notched paper

B Coated paper (e.g., brochure)

m  Overhead projector film

To prevent paper feeding errors and damages to the ADF
unit, strictly follow the instructions below:

® Remove all small objects e.g., paper clips, pins, staples
or any other fasteners attached, before loading the
paper into the ADF.

® Make sure the paper is completely flat with no creased

or curled corners.

Qn‘“‘"‘““:' ® Avoid scanning documents with pencil lead and
newspaper clippings as they will make the ADF
exposure glass and the inner ADF dirty. If you have to
scan such paper, clean the scanner frequently (refer to
“Chapter lll. Care and Maintenance” of this guide for
more information).

® The paper for each batch scanned by ADF can be of
the same or different weights. However, make sure the
length of each scan batch is the same.

Attention

However, use the flatbed to manually scan documents if they meet any of the

following conditions:
® Paper lighter than 50 g/m? (14 Ib.) or heavier than 105 g/m? (28 Ib.)

Paper with clips or staples attached
Paper with inconsistent thickness, e.g., envelops
Paper with wrinkles, curls, folds, or tears
Paper with an odd (non-rectangular) shape
Tracing paper
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® Carbon paper, pressure sensitive paper, carbonless paper
® |tems other than paper, e.g., cloth, metal foil.
® DO NOT use the ADF to scan photographic sheets or
particularly valuable document originals; wrinkles or
Qmmﬂm’- other damages can happen in case of paper feeding
- errors.
® DO NOT place paper with wet ink or correction fluid
onto the flatbed glass or into the ADF. Wait few
minutes for it to get dry.

Attention

Loosening Documents (for ADF Scan)
Before loading documents into the ADF, loosen them as follows:
1. Fan the documents so that no two pages are sticking together.

2. Hold the documents upside down with both hands, and then gently push them
onto a flat surface to align the edges of all documents.

This will allow documents being fed into the ADF one at a time and prevent paper-
feeding errors.

PLACING DOCUMENTS

Using the Flatbed

1. Open the scanner's document cover.

2. Place the document onto the scanner glass headfirst and face-down. Align the

center top of the document with the = on the reference mark.

17



3. Gently close the document cover.

Using the ADF

1. Load the documents, headfirst and face down, toward the center of the ADF
paper chute and all the way into the ADF until touching the bottom.

For single-sided scans, load the documents face down so that the side to be
scanned faces towards the paper chute.

For double-sided scans, load the desired page order of documents face down
so that the side to be scanned faces towards the paper chute.

2. If you are to scan longer documents, unfold the paper chute extension and side
guide to provide further support for the documents.




3. Adjust the paper width slider for the paper size you are using. The paper width
slider should be gently touching both sides of the documents.

o — 2

® DO NOT load more than 50 sheets of paper (70 g/m?,
18 Ib.) to the ADF.

® Paper scanned from the ADF must be a minimum of
5.08 x5.08 cm (2" x 2", W x L).

® Make sure there are no gaps between the document
stack and the paper-width slider; otherwise, the

QN"“H”:' scanned images can be skewed.

Attention ® Although the documents should be loaded firmly in
place ensuring optimum scanning accuracy, they
should never be wedged in so tightly that the process
of feeding them through the scanner is strained.

® Do not load additional paper into the ADF while the unit
is feeding and scanning.

PLACING BUSINESS CARDS

1. Load the business cards, headfirst and face down, toward the center of the
ADF and all the way into the ADF until touching the bottom.

For single-sided scans, load the business cards face down.

For double-sided scans, load the business cards in desired order.
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2. Adjust the paper width slider to the business card width. The paper width
slider should be gently touching both sides of the business cards.

Qﬂ“‘““m:' ® Don't load more than 20 business cards in one batch.

Attention

PLACING PLASTIC CARDS

The plastic card can be embossed credit card, driver license, ID card, insurance
card, medic-care card or any membership card. Make sure to load the embossed face
of the embossed card face down into the scanner.

1. Horizontally load the plastic card, headfirst and face down, toward the center
of the ADF.

For single-sided scans, load the card face down.

For double-sided scans, load the card in desired order.

2. Adjust the paper width slider to the card width. The paper width slider should
be gently touching both sides of the card.

® Make sure the plastic cards you wish to scan are
Qﬁmwm} horizontally loaded into the ADF.
Maximum thickness of each plastic card is 1.2 mm.

Attention

PLACING DOCUMENTS WITH THE PROTECTION SHEET

To avoid paper jam and documents be scratched, the protection sheet is designed
for you to load and protect special documents. It allows you to scan a document that
is not easy to load into the scanner. For example, paper with an odd (non-rectangular)
shape, wrinkles, curls, folds, as well as stamps, magazine and newspaper clippings.

20



You can also use the protection sheet when you scan photographs and valuable
documents so they won't be scratched.

1. Open the ADF cover by pulling the cover open lever.

Cover open lever

ADF cover

2. Remove the pad module by pinching both sides of the pad module and pull it
out.

3. Close the ADF cover by pushing it back down until it snaps back into place.

4. To scan a document with large page size, spread the page to be scanned
facing outwards and neatly fold it in half from the center.

—
|

AAA

AAA

- —

|

=== L]

[ —
|
|

Il

5. Open the protection sheet and place the document inside, headfirst and face
down, toward the center of the sheet and all the way until touching the bottom
of the sheet. Align the top of the document to the side of the protection sheet
with the black line, and the folded portion toward to the right side of the sheet.
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6. Load the protection sheet into the scanner, and align the protection sheet with
the black line toward the center of the ADF.

.

1

7. For single-sided scans, load the protection sheet face down.

For double-sided scans, load the protection sheet in desired order.

8. Adjust the paper width slider to the protection sheet width. The paper width
slider should be gently touching both sides of the sheet.

QN"““N:' please load the sheet of papers one by one.

Attention

® When you are using the protection sheet for scanning,

SCANNING DOCUMENTS

There are four different ways to operate the scanner:

1.

2.
3.
4.

By acquiring images from the scanner through our TWAIN interface within
any TWAIN-compliant application programs.

By scanning images within our FounderScan software.
By scanning from the buttons on the scanner front panel.

By scanning from FounderAction's Execute menu on the screen.

The TWAIN interface, FounderScan and FounderAction software is automatically
installed to your system along with the scanner driver.
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Before you start scanning, check the following:

® The power of both your computer and scanner is
QﬂmwM} turned on.

Attention ® Theicon '@ appears on the Windows system tray.
® Paper is appropriately placed on the scanner flatbed
glass or loaded into the ADF.

Scanning via TWAIN Interface

The TWAIN program is a very important piece of software that comes with your
scanner. This program acts as an interface between the scanner hardware and the
image-editing software you are using to view and edit images. The TWAIN program
allows you to adjust a number of settings to define the quality of the scanned image.

The following describes how you may use our bundled image-editing application
(NewSoft Presto! ImageFolio), OCR software (ABBYY FineReader 6.0 Sprint, DI
Express) and Business card Recognition Software (HotCard BizCard Finder) to scan
via TWAIN interface. When you get familiar with the scanning, you may alternatively
use other TWAIN compatible scanning program or image-editing application to do your
scanning projects.

Select the Scan Source:

If you have more than one scanner or other imaging devices installed on your
computer, you need to set this scanner as the default scanning source before you
acquire TWAIN program.

1. For NewSoft Presto! ImageFolio: From the File menu, click Select Source.

In the window that opens, choose this scanner and then click the OK button
to set this scanner as the default scanning source.

2. For ABBYY FineReader 6.0 Sprint: From the File menu, click Select
Scanner.... In the window that opens, choose this scanner and then click the
OK button to set this scanner as the default scanning source.

3. For DI Express: From the File menu, click Select Scanner Model. In the
window that opens, choose this scanner and then click the Select button to
set this scanner as the default scanning source.

4. For HotCard BizCard Finder: From the Main Toolbar, click Settings >
Acquire Options > Flatbed/TWAIN Scan, and then click Settings >
Acquire Options > Select Flatbed/TWAIN Scanner. In the window that
opens, choose this scanner and then click the OK button to set this scanner
as the default scanning source.

Scan within NewSoft Presto! ImageFolio:
1. Click the Windows Start button to launch Presto! ImageFolio.
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2. Within Presto! ImageFolio, click File > Acquire > Acquire.

3. In the TWAIN window that opens, select Flatbed Reflective or ADF (Front
Side) as the Scan Type if you want to scan single-sided documents, or select
ADF (Duplex) to scan double-sided documents.

Profile: | j | Manage... |

HMain lgdvanced] Preferences | About | I:I]'||

Scan Type: [ADF [Duplex) |
S
v Merge Pages
(" Horizontally ™ Wertically

[ Manual Merging Adjustment

Page Size: |Aut0matic Size j
Scan ode: | 24-bit Color =l
Besolution: | 200 -

Brightness: ﬂ J ﬂ ,U—
Contrast; ﬂ J ﬂ ,D—

Page Seftings
r

Rotate: Mone, Imverse: O
Flip Horizontally: OFf, Flip Vertically: Qff

Configure...

(=000, V=000, W=2167, H=20.71  GAZME | Fronit Side Rear Side
Preview | Exit | Help | [ Luto Density Auto Crop @ ﬂ

4. Adjust the scanning settings. For ADF (Duplex) scan, you can tailor settings

individually for front and rear sides of the documents. Click Front Side button
to adjust the scanning settings of document front side and then click Rear Side
button to adjust the scanning settings of document rear side.
You can enable the function of Merge Pages only when you select ADF
(Duplex) as Scan type and Automatic Size as Page Size to output the scan
images of both front and rear sides in one image. After the function of Merge
Pages is enabled, you can make the selection of Horizontally to generate both
front and rear image data horizontally in a joined image (the rear image will be
placed at the right side next to the front image), or make the selection of
Vertically to generate both front and rear image data vertically in a joined
image (the rear image will be placed below the front image).

5. Load one page of the document and click the Preview button. The scanned
image should appear in the Preview Window. To define the margins and crop
out sections of the image you don’t want scanned, use the mouse to click and
drag the corners or sides of the scan area borders. Adjust the scan settings
again if the preview image doesn’t satisfy your needs.

6. Load all pages of the document and click the Scan button.

7. When the scan finishes, click the Exit button to close the TWAIN window. The
scanned images are displayed in Presto! ImageFolio, and you may perform the
image editing tasks.
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Click the Help button within the TWAIN window for more information about the

settings.

Scan within ABBYY FineReader 6.0 Sprint: FINEBEABEH

1.

POWERED B Y|ABBYY

Click on the Windows Start button, point to Programs > ABBYY FineReader
6.0 Sprint and then click ABBYY FineReader 6.0 Sprint to launch the
FineReader program.

To scan one page from the scanner:

Click @ and then click Scan Image from its drop-down menu.

To scan multiple pages from the scanner:

Click @E and then click Scan Multiple Images from its drop-down menu.
In the TWAIN window that opens, select Flatbed Reflective or ADF (Front
Side) as the Scan Type if you want to scan single-sided documents, or select
ADF (Duplex) to scan double-sided documents.

Adjust the scanning settings. For ADF (Duplex) scan, you can tailor settings
individually for front and rear sides of the documents. Click Front Side button
to adjust the scanning settings of document front side and then click Rear Side
button to adjust the scanning settings of document rear side.

You can enable the function of Merge Pages only when you select ADF
(Duplex) as Scan type and Automatic Size as Page Size to output the scan
images of both front and rear sides in one image. After the function of Merge
Pages is enabled, you can make the selection of Horizontally to generate both
front and rear image data horizontally in a joined image (the rear image will be
placed at the right side next to the front image), or make the selection of
Vertically to generate both front and rear image data vertically in a joined
image (the rear image will be placed below the front image).

Load one page of the document and click the Preview button. The scanned
image should appear in the Preview Window. To define the margins and crop
out sections of the image you don’t want scanned, use the mouse to click and
drag the corners or sides of the scan area borders. Adjust the scan settings
again if the preview image doesn’t satisfy your needs.

Load all pages of the document and click the Scan button.

The scanned images are displayed in the FineReader main window, and you
may proceed OCR to convert images into pdf or editable text formats.

Inforfriation button.

If you usually scan images with the same settings, you can

define a scan profile to save the settings you have configured
0 by entering a name or description for this new profile in the

white area beside the word Profile and then click the Save

Next time when you want to scan similar documents and
apply the same settings, you can just select this profile
from the drop-down list and then click the Scan button.
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Click the Help button within the TWAIN window for more information about the
settings.

Scan within DI Express:

This OCR program is only compatible with Traditional Chinese,
Qﬂmnﬂm} Simplified Chinese, Japanese and Korean operation systems.

Attention

1. Click the Windows Start button to launch DI Express.

2. Within DI Express, click the File > Scan.

3. In the TWAIN window that opens, select Flatbed Reflective or ADF (Front
Side) as the Scan Type if you want to scan single-sided documents, or select
ADF (Duplex) to scan double-sided documents.

4. Adjust the scanning settings. For ADF (Duplex) scan, you can tailor settings

individually for front and rear sides of the documents. Click Front Side button
to adjust the scanning settings of document front side and then click Rear Side
button to adjust the scanning settings of document rear side.
You can enable the function of Merge Pages only when you select ADF
(Duplex) as Scan type and Automatic Size as Page Size to output the scan
images of both front and rear sides in one image. After the function of Merge
Pages is enabled, you can make the selection of Horizontally to generate both
front and rear image data horizontally in a joined image (the rear image will be
placed at the right side next to the front image), or make the selection of
Vertically to generate both front and rear image data vertically in a joined
image (the rear image will be placed below the front image).

5. Load one page of the document and click the Preview button. The scanned
image should appear in the Preview Window. To define the margins and crop
out sections of the image you don’t want scanned, use the mouse to click and
drag the corners or sides of the scan area borders. Adjust the scan settings
again if the preview image doesn’t satisfy your needs.

6. Load all pages of the document and click the Scan button.

7. The scanned images are displayed in DI Express workspace, and you may
proceed OCR to convert images into pdf or editable text formats.

Click the Help button within the TWAIN window for more information about the

settings.

Scan within HotCard BizCard Finder:
1. Click on the Windows Start button, point to Programs > Business card
Recognition Software and then click Business card Recognition Software
to launch the Business card Recognition Software.

2. Within Business card Recognition Software, click Scan e from the main

toolbar.
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3. In the TWAIN window that opens, select Flatbed Reflective or ADF (Front
Side) as the Scan Type if you want to scan single-sided business cards, or
select ADF (Duplex) to scan double-sided business cards.

4. Adjust the scanning settings (Paper Size: Automatic Size, Resolution: 300). For

ADF (Duplex) scan, you can tailor settings individually for front and rear sides
of the business cards. Click Front Side button to adjust the scanning settings
of front side and then click Rear Side button to adjust the scanning settings of
rear side.
You can enable the function of Merge Pages only when you select ADF
(Duplex) as Scan type and Automatic Size as Page Size to output the scan
images of both front and rear sides in one image. After the function of Merge
Pages is enabled, you can make the selection of Horizontally to generate both
front and rear image data horizontally in a joined image (the rear image will be
placed at the right side next to the front image), or make the selection of
Vertically to generate both front and rear image data vertically in a joined
image (the rear image will be placed below the front image).

5. Load one business card and click the Preview button. The scanned image
should appear in the Preview Window.

6. Load all business cards and click the Scan button.

7. The scanned images are displayed in the BizCard Finder main window, and you
may proceed OCR to convert images into editable text formats.

Click the Help button within the TWAIN window for more information about the

settings.

Scanning from FounderScan Program

1. Click the Windows Start button to launch FounderScan.

Scan Profile
File ES1 Vew Soas bvoge o =
Select the nmm:u a:.uum.:m :J & : iy <«—Toolbar
scanner - ™* =) |8 Febee Gl 4 15 N || O
- 4] -] 11 -+ N
Viewer
—
Folder P
Pane
Browser
+—
Pane

Pl Progegi A& Fowe fisk sgunae: 6.4 Gl

Scan Settings Pane
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2. Within FounderScan, select this scanner from the drop-down list of
[g |Scannerrv10de| MName ﬂ

3. Select a document from the Folder Pane to store the scanned images.

(To create a new folder and/or a new document, click the New Folder and/or
New Document button from the toolbar.)

4. Select an appropriate scan profile. (You may click the tab of Scan Settings
Pane to check if the current settings of the selected scan profile meet your
needs. If not, you may click the Create or Manage button beside the Scan
Profile to create a new profile or modify an existing profile.)

5. Click the Scan — Append button from the toolbar.

6. When the scan finishes, all scanned images are displayed on the Browser
Pane. The last scanned image appears on the Viewer Pane.

Alternatively you may click the Scan Wizard button from the toolbar to let Scan
Wizard guide you through the entire scan process.

You may also tailor your own user interface of FounderScan such as the toolbar
buttons, Viewer Pane, Browser Pane, etc.

Refer to the online help of FounderScan to explorer more about FounderScan!

Scanning from the Scanner’s Front Panel

To complete your scanning projects by using the scanner buttons is very easy and
convenient. The number of scanning task displayed on the scanner’s front panel is
configured through FounderAction. FounderAction offers you quick access to the most
frequently-used scanning functions. They are especially useful when you need to
repeatedly scan with the same settings and send images to the same destination.
Before performing your first scan via scanner buttons, you are recommended to
configure the button settings to your needs and preferences first.

Scan from the Scanner Buttons

1. Place the document or images onto the scanner. (Refer to “Chapter II.
Scanning” of this guide for more information in placing paper into the ADF or on
the flatbed glass properly.)

2. Check current button settings by viewing the memo label or the Button
Configuration window. If needed, you may also modify settings to meet your
current needs. (Refer to “View Button Settings” and “Configure Button Settings”
below for more information.)

3. Press the UP or DOWN button to select the desired task.

4. Press the Scan button.
The scanner starts to scan immediately and carry out the corresponding action
according to settings you have set up in the Button Configuration window.
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. Place only text documents for OCR purposes. Do not scan a
QA“‘““““: photo using the OCR button.

Attention

Configure Button Settings

Within the “Button Configuration” window, you can find a row of icons running
through the left side of the window. Each icon represents a scanning task, and the
number underneath corresponds to the function number displayed on the scanner front
panel. Nine frequently-used scanning tasks are pre-configured for your convenience to
start scanning immediately. You may, however, customize the settings of every nine
tasks to best meet your needs and preferences. Follow the steps described below:

1. Do one of the following to open the Button Configuration window:
® Double-click the icon '@ in the Windows system tray.

® Right-click the icon '@ in the Windows system tray, and then choose
Button Configuration... in the pop-up menu that opens.

2. Select a task number by clicking on the icon at the left side of the window.

3. Select the desired function from the drop-down list of Button Template and
adjust button settings.

0 It's optional for you to write down the customized button
number settings on the included memo label and place this
memo anywhere on the scanner.

Information

Click the Help button within the Button Configuration window for more information
about the settings.

View Button Settings

There are three ways to view the button settings:
® Double-click the icon '@ in the Windows system tray.

® Right-click the icon '@ in the Windows system tray, and then choose
Button Configuration... in the pop-up menu that opens.

® View your memo if you write down the customized button number settings
on the memo label.
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Scanning from the On-screen FounderAction’s Execute Menu

You may also use FounderAction's on-screen Execute menu to perform the same
scanning tasks. The FounderAction program provides a quick and convenient way to
perform various scanning functions. Follow the steps described below:

1. Place the document or images onto the scanner.

2. Check current button settings by viewing the memo label or the Button
Configuration window. If needed, you may also modify settings to meet your
current needs.

3. Right-click the icon '@ in the Windows system tray, and then choose
Execute in the pop-up menu that opens.
4. Click the desired button function item in the pop-up menu.
The scanner starts to scan immediately and carry out the corresponding action
according to settings you have set up in the Button Configuration window.
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CHAPTER III. CARE AND MAINTENANCE

Your scanner is designed to be maintenance-free. However, constant care and
maintenance can keep your scanner working smoothly.

CLEANING THE SCANNER

Paper powder, dust, ink and toner from paper being scanned may make the
scanner glass and the inner ADF dirty, which leads to poor image quality or document-
feeding errors. How often to clean your scanner depends on the type of paper and
number of pages being scanned.

Perform the following procedures to clean the scanner surface, scanner glass and
the ADF unit. Gently wipe locations described herein. Do not rub too hard.

® Before cleaning the scanner, turn off the scanner and

disconnect the scanner’s power cable and USB cable,

A and then wait a few minutes for the glass and/or the
inner ADF to cool to ambient temperature.

Warning ® Wash your hands with soap and water after cleaning
the scanner.

Cleaning Materials

Have the following cleaning materials ready to clean the scanner:
® soft, dry, lint-free cloth (or a cotton swab)
® non-abrasive cleaner—Isopropyl alcohol (95%). DO NOT use water.

Q Alternatively you can use glass cleaner or neutral
Pttentior- detergent for windows cleaning to clean the scanner

Attention  9'@sS:

However, DO NOT use either of them to clean the ADF
feed roller or pad module.

Use of other cleaning materials could damage your scanner.

Cleaning the Flatbed
1. Open the document cover.

2. Gently wipe the following areas with the cloth dampened with the cleaner.
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Clean Document Pad & Scanner Glass:

Document

Pad —

Scanner
Glass

ka-_ Do not spray cleaner directly onto the scanner glass.
" Excess liquid residue may fog or damage the scanner.

Attention

3. Wait for cleaned areas to dry completely.

4. Gently close the document cover.

Cleaning the ADF
1. Open the ADF cover by pulling the lever.

-

gi 5 .-T,._;-;fql

Cover open lever

ADF cover

2. Gently wipe the following areas with the cloth dampened with the cleaner. Be
careful NOT to scratch their surfaces.

Clean Feed Roller:
Wipe the Feed Roller from side to side and then rotate it. Repeat this until its
entire surface is cleaned.
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Clean Pad Module:
Wipe the Pad Module from top to bottom (in the direction of arrow shown in
below picture). Be careful not to damage the pick springs of the pad.

Clean ADF Glass:

Q . Do not spray cleaner directly onto the scanner glass.
Excess liquid residue may fog or damage the scanner.

Attention

3. Wait for cleaned areas to dry completely.

4. Close the ADF cover by pushing it back down until it snaps back into place.
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REPLACING CONSUMABLES

As a guideline, it is recommended to replace the pad module every 25000 sheets
of scans. It is also recommended to purchase a new protection sheet if it can’t be used

for scanning due to serious damage.

Replacing the Pad Module

1. Open the ADF cover by pulling the cover open lever.

Cover open lever

ADF cover

2. Remove the pad module by pinching both sides of the pad module and pull it

out.

3. Install the new pad module by inserting the tabs on the module onto their slots
on the scanner.

4. Close the ADF cover by pushing it back down until it snaps back into place.
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CALIBRATING THE SCANNER

Q ; Please uninstall the extended paper width sliders before you
Duttention- . .
B start the calibration.

Attention

Calibrate the scanner if colors appear in areas that should be white, or colors of
the scanned image and the original vary a lot. This allows you to adjust and
compensate for variations that can occur in the optical component over time by its
nature.

The following describes how to calibrate the scanner:

1. The Calibration Sheet, marked with an arrow on either edge at both sides, is
used specially for ADF Scanning calibration.

2. Insert the special calibration sheet into the ADF of the scanner, with an arrow
toward the scanner buttons.

. Please insert the special calibration sheet included with the
Qﬂmww; scanner. Alternatively you may also use any plain white
sheet of paper sized in A4 (216 by 297 mm) instead;
however, the calibration effect may be less good than the
special calibration sheet.

Attention

3. Click Start > Programs > Your scanner model name > Calibration Wizard.

4. Click Next from the Calibration Wizard that pops up and then click Calibrate
Now.... Start to begin the Flatbed Reflective calibration process. After the
calibration is complete, click OK.

5. Click Calibrate Now.... Click on the Start button to begin the ADF calibration
process.

6. The scanner pulls the calibration sheet through the scanner, which completes
this scanner calibration. After the calibration is complete, click OK and then
click Finish.
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CHAPTER IV. TROUBLESHOOTING

If you encounter problems with your scanner, please review the installation and
scanning instructions contained in this guide.

Before you ask for customer service or repair, please refer to the information in this
chapter and consult our FAQ (Frequently Asked Questions) in which you can find
useful self troubleshooting information. From the Windows START menu, point to
Programs > Your Scanner Model Name, and then click FAQ.

SCANNER CONNECTION

The first step to take when troubleshooting connection problems with your

scanner is to check all physical connections. The icon '@ located on the Windows
system tray, indicates if the scanner software is properly launched and the scanner and
computer are communicating with each other.

Appearance Status

The program has been successfully launched and the

scanner is connected with the computer, ready to scan

images.

@ The scanner is not connected with the computer. Or, the
scanner power is not switched on.

No Display  |yoy have chosen to terminate the program, no matter the

scanner is connected or disconnected with the computer.

CLEARING PAPER JAMS

If a paper jam in the ADF happens, please perform the following steps:
1. Remove any unjammed documents still loaded into the ADF.

2. Open the ADF cover by pulling the cover open lever.

Cover open lever

ADF cover

36



Gently but firmly pull the jammed documents out of the ADF. Try to avoid
creasing or wrinkling the documents.

Q ; Do not try to pull jammed or half-scanned documents out of
the ADF without first opening the ADF cover. Doing so may
Attention permanently damage the ADF.

Close the ADF cover by pushing it back down until it snaps back into place.
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APPENDIX A: SPECIFICATIONS

Founder 150

Optical Resolution

Flatbed: 1200dpix2400 dpi;
ADF: 600dpix600 dpi

Scanning Speed

30 ppm/60 ipm (200 dpi, grayscale mode, A4 Portrait)

ADF Capacity

50 sheets (70 g/m2 or 18 Ib.)

Color Depth 48-bit
Interface USB 2.0
Scan Area ADF:  Maximum 216mmx356mm
Flatbed: Maximum 216mmx297mm
Paper Sizes ADF: Minimum 50.8x50.8mm
P ADF: Maximum 220x356mm
Physical Dimensions | 481mmx327mmx203mm
Weight 4.5 Kgs
Power Adapter 24V, 0.75A
Protocols TWAIN Compliant
Operating 57 to 35°C
Temperature

Relative Humidity

20% to 80%

AC Power

100V to 240V

Hardware specifications may change at any time without prior notice.
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APPENDIX B:
CUSTOMER SERVICE AND WARRANTY

For further assistance, visit our website or call our customer support phone
number listed on the last page of this guide. One of our representatives will be happy to
assist you from Monday through Friday in office working hours.

To avoid delays, please have the following information available before calling:
Scanner name and model number

Scanner serial number (Located at the bottom of the scanner)

Scanner CD version and part number

A detailed description of the problem

Your computer manufacturer and its model number

The speed of your CPU

Your current operating system and BIOS (optional)

Name of software package(s), version or release number and manufacturer
of the software

Other USB devices installed

STATEMENT OF LIMITED WARRANTY

This Statement of Limited Warranty applies only to the options you originally
purchase for your use, and not for resale, from an authorized reseller.

The manufacturer warranty includes all parts and labor, and is not valid without
the receipt of original purchase. To obtain warranty service, you may contact the
authorized dealer or distributor, or visit our website to check out the available service
information, or send a request via E-mail for further help.

If you transfer this product to another user, warranty service is available to that
user for the remainder of the warranty period. You should give your proof of purchase
and this statement to that user.

We warrant that this machine will be in good working order and will conform to its
functional descriptions in the documentation provided. Upon provision of proof of
purchase, replacement parts assume the remaining warranty of the parts they replace.

Before presenting this product for warranty service, you must remove all programs,
data and removable storage media. Products returned without guides and software will
be replaced without guides and software.

This Limited Warranty service does not provide for carry-in exchange when the
problem results from accident, disaster, vandalism, misuse, abuse, unsuitable
environment, program modification, another machine or non-vendor modification for
this product.



If this product is an optional feature, this Limited Warranty applies only when the
feature is used in a machine for which it was designed.

If you have any questions about your Limited Warranty, contact the approved
retailer from whom you bought the product or the manufacturer.

THIS LIMITED WARRANTY REPLACES ALL OTHER WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. HOWEVER,
SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE
LIMITED IN DURATION TO THE WARRANTY PERIOD. NO OTHER WARRANTIES
APPLY AFTER THAT PERIOD.

Some jurisdictions do not allow limitations on how long an implied warranty lasts,
so the above limitation may not apply.

Under no circumstances are we liable for any of the following:
1. Third party claims against you for losses or damages.
2. Loss of, or damage to, your records or data; or

3. Economic consequential damages (including lost profits or savings) or
incidental damages, even if we are informed of their possibility.

Some jurisdictions do not allow the exclusion or limitations of incidental or
consequential damages, so the above limitation or exclusion may not apply to you.

This Limited Warranty gives you specific legal rights, and you may also have other
rights that vary from jurisdiction to jurisdiction.

FCC RADIO FREQUENCY STATEMENT

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses and can radiate radio frequency energy and, if
not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference
will not occur in a particular television reception (which can be determined by turning
the equipment off and on), the user is encouraged to try to correct the interference by
one or more of the following measures:

® Reorient or relocate the receiving antenna.

® Increase the separation between the equipment and receiver.

® Connect the equipment to an outlet on a circuit different from that which the

receiver is connected.

40



® Shielded interconnect cables and shielded power cord which are supplied
with this equipment must be employed with this equipment to ensure
compliance with the pertinent RF emission limits governing this device.

® Consult the dealer or an experienced radio/TV technician for help if the
conditions persist.

® Changes or modifications not expressly approved by the manufacturer or
authorized service center could void the user’s authority to operate this
equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

41



	Trademarks
	Liability
	Copyright
	Environmental Information
	Screen Examples in This Manual
	Table of Contents

	Introduction
	How to Use This Guide
	Conventions of This Guide
	A Note about Icons

	Safety Precautions
	Minimum System Requirements 
	Box Contents 
	 
	The Scanner Features

	Chapter I. Installing the Scanner
	Software Installation Requirements
	Hardware Requirements 
	Installing and Setting up the Scanner
	Choose a Proper Site First!
	Step 1.  Connecting the Scanner to Your Computer
	Step 2.  Installing the Software
	Step 3.  Install the Extended Paper Width Slider
	Step 4.  Testing the Scanner
	To test the flatbed scanning:
	To test the ADF scanning:


	Installing Additional Software

	Chapter II. Scanning
	Preparing Documents
	Checking Document Conditions
	Loosening Documents (for ADF Scan)

	Placing Documents
	Using the Flatbed
	Using the ADF

	Placing Business Cards
	Placing Plastic Cards
	Placing Documents with the Protection Sheet
	Scanning Documents
	Scanning via TWAIN Interface
	Select the Scan Source:
	Scan within NewSoft Presto! ImageFolio:
	Scan within ABBYY FineReader 6.0 Sprint:  
	Scan within DI Express: 
	Scan within HotCard BizCard Finder:

	Scanning from FounderScan Program
	Scanning from the Scanner’s Front Panel
	Scan from the Scanner Buttons
	Configure Button Settings
	View Button Settings

	Scanning from the On-screen FounderAction’s Execute Menu


	Chapter III. Care and Maintenance
	Cleaning the Scanner
	Cleaning Materials
	Cleaning the Flatbed
	Clean Document Pad & Scanner Glass:

	Cleaning the ADF
	Clean Feed Roller:
	Clean Pad Module:
	Clean ADF Glass: 



	Replacing Consumables
	Replacing the Pad Module

	Calibrating the Scanner

	 
	Chapter IV. Troubleshooting
	Scanner Connection
	Clearing Paper Jams

	 
	Appendix A: Specifications 
	Founder I50

	Appendix B: Customer Service and Warranty
	Statement of Limited Warranty
	FCC Radio Frequency Statement



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




